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Purpose and Overview 

The purpose of this manual is to provide an overview 

of Microsoft Excel tools and functions which are most 

useful to improve daily operational efficiency.  
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SECTION I: What is Excel? 

Microsoft Excel is a spreadsheet application that is commonly used for a variety of uses. At its core, Excel 

is a table consisting of rows and columns. Excel is composed of rows and columns and uses a spreadsheet to 

display data. Features include: calculation, graphing tools, pivot tables, and a macro programming language 

called Visual Basic for Applications. 

What can I do with this? 

The data within a table can be sorted by any column, which means that the rows can be ordered by last 

name or first name alphabetically, by the ID number ascending or descending, by the amount paid 

ascending or descending, or by the date. You can also filter the data in the table to have only specific 

values show. 

SECTION II: Cells, Rows, and Columns 

What is a cell? 

A cell, outlined in green below, is an individual block within a table in which you can enter values, such 

as words or numbers. 

What are rows and columns? 

Rows, outlined in red below, are a horizontal group of cells. Columns, outlined in blue below, are a 

vertical group of cells.  

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

Inserting rows and columns 

To Add a Row: 

1. Select the entire row below where you want to add the new row. 

This is a row 

This is a column 

This is a cell 

 

http://en.wikipedia.org/wiki/Spreadsheet
http://en.wikipedia.org/wiki/Application_software
http://en.wikipedia.org/wiki/Pivot_table
http://en.wikipedia.org/wiki/Visual_Basic_for_Applications
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2. Right click, select Insert.  

 
 

  

To Add a Column 

1. Select the column to the right of where you want to add the new column 

 
 

2. Right click, select Insert. 
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Section III: Navigation 

Navigating through your spreadsheet doesn’t have to be difficult. Using some very simple keystrokes, you 

can move from one end of your spreadsheet to the other faster than using the scroll bar.  

Moving Between Cells 

Use the arrow keys on your keyboard to move from one cell to another 

 

Use the Tab key to move horizontally to the right. Hold the Shift key and press the Tab key to move 

horizontally to the left.  

 

Use the Enter key to move vertically downward. Hold the Shift key and  press the Enter key to move 

vertically upwards.  

Selecting Multiple Cells 

To select a range of data: 

1. Select the first cell in the data range. 

2. Hold the Shift key. 

3. Select the last cell in the data range. 

OR 

Select the beginning range of data, drag the cursor to select the range of data  

Selecting Entire Rows and Columns 

 Excel organizes a data sheet by numbering the rows and lettering the columns.  

To select an entire row: 

Select the number of the row 

 

To select an entire column: 

Select the letter of the column.  

Selecting Multiple Rows and Columns 

To select multiple rows or columns 

1. Select the entire first row 

2. Hold the Shift Key 

3. Select the entire last row of the range of data 
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SECTION IV: Formatting  

Formatting in Excel allows you to change the appearance of cells or the appearance of the spreadsheet as a 

whole.  

Cells 

Formatting cells allow you to change the appearance of the value within the cell without changing the 

value, such as converting number into a currency or percentage value.  

 

To Format a Cell: 

1. Select the cell or cells to format  

2. Right click and select Format Cells. 

 
 

The Format Cells dialogue box will appear  

 
 

 

 

 

 

 

 

 

 

 



 

8 

 

To convert a numeric value into an accounting value: 

Select Accounting from the list of Categories.  

 
 

 

 Click Ok.   

 
 

Tables 

A table is a way of formatting data so that data may be sorted. Tables also display rows in alternating 

colors to make the data easier to read. 

 

Choosing a Table Style to Create a Table 

To Choose a Table Style: 

1. Select the range of cells to include in the table.  

2. Choose Table located on the Insert tab. 
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The Create Table dialogue box will appear.  

 
 

If you selected a range of data to include in the table, the table contents will already be populated in the 

Where is the data for you table field.  

 

To include headers in the table, select the My Table has Headers checkbox.  

 

 

 

 

To Create a Table from the Home Tab: 

1. Select the range of cells to include in the table.  

 

2. Select Format as Table.  

 

3. Follow the steps listed above to create a table.  

 
 

Adjust the Table Style 

Select the table, and choose the Table Style located on the Design tab.  

 

 
 

Creating or Deleting a Custom Table Style 

To Create a Custom Table: 

1. Select your data  

 

2. Choose Format as Table.  
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3. Select New Table Style at the bottom of the dropdown menu. 

 
 

 
 

 

 

The New Table Quick Style dialogue box will appear. 

 

 
 

4. Select any of the table elements to format the table as desired.  

 

The Preview box allows you to view the table before completing formatting changes.  

Select OK to apply the table to your data.  

 

To Set this Table as a Default Table:  

1. Select the Set as default table quick style for this document option 

 

 

 

To Delete a Custom Style: 

1. Select Format as Table. 

2. Find the custom style located within the Custom section 

3. Right click on the style, select Delete.  
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Removing a Table Style 

To Remove a Table Style from and Existing Table: 

1. Select the contents of the table.  

2. Choose the More button.  

 
 

3. Choose Clear.  

 
 

This will clear the table style but the data will still remain in a table format.  

 

Converting a Table to a Range of Data 

To Convert an Existing Table to a Range of Data: 

1. Select the table. 

2. Select Convert to Range.  

3. Select Yes.  

 
 

Formatting Table Elements 

To Format the Elements of a Table Style: 

1. Select the contents of the table.  

2. Table Style Options contains various table formatting options.  
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3. Select the desired checkboxes to change the format of the table.  

 

Header Row – Creates a row at the top of the table for headers.  

Total Row – Creates a row at the bottom of the table populates a total sum for each column. 

Banded Rows – Shades every other row in the table.  

First Column – Shades the entire first column the same color as the header row.  

Last Column – Shades the entire last column the same color as the header row. 

Banded Columns – Shades every other column in the table. 

Pivot Tables 

A pivot table is a data summarization tool within Excel. A pivot table can sort, count, total and average 

the data within a table or spreadsheet.  

 

To Insert a Pivot Table:  

1. Select any cell in your data range.  

2. Select Pivot Table located on the Insert tab.  

 
 

 The Create PivotTable dialogue box will appear.   
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 Excel will automatically select the data for the pivot table.  

 Excel will also automatically select New Worksheet as the destination for the pivot table.  

 

3. Click Ok.  

A new worksheet will be added for the pivot table.  

 

Initially, the spreadsheet will appear blank.  

 

The PivotTable Field List is located to the right. 

 
       

4. Choose the fields to see by selecting column headers within Choose Field to Add to Report.  

 

You can also drag and drop a field into a Pivot table Area within the dialogue box. 

 

Pivot Table Areas:  

Report Filter – Filters the entire pivot table based on fields in that area 

Column Labels – Adds columns to the table based on fields in that area;  

Row Labels – Adds rows to the table based on fields in that area;  

Values – Performs an Auto Sum action in the table based on the fields in that area.  

 

In a pivot table, you can sort and filter like you can with any other data range.  

 

To Change the Summary Calculation Value: 

1. Click on any cell in the Grand Total row 

2. Select Value Field Settings from the menu.  
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This will open the Value Field Settings dialogue box: 

 

 
 

3. Choose the calculation you want to summarize.  

4. Click Ok. 

 

The Values field will change to the selected calculation.  

Conditional Formatting 

Conditional formatting allows you to change the appearance of a cell, based on criteria that you define, 

using predetermined rules in Excel.  

Highlight Cells Rules 

Using the highlight cells rules, you can highlight cells in your data that are greater or less than a value, 

between or equal to a value or contain a specified or duplicate value.  

Greater Than 

To highlight cells which contain data greater than a specific value: 

1. Highlight the data range.  

 

2. Select the Conditional Formatting tool 

 
 

3. Hover over Highlight Cells Rules to reveal the menu of different rules.  
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4. Select Greater Than from the menu to open the Greater Than dialogue box:  

 
 

5. Enter the value that you want to set as your lower limit for the Greater Than condition.  

6. Select the type of formatting from the dropdown menu.  

7. Select Ok.  

 

The cells which contain a value greater than the value you specified will now appear with the cell 

formatting which you selected.  

Less Than 

To highlight cells that contain data less than a specific value: 

1. Highlight the data range.  

2. Select Conditional Formatting.  

   
3. Hover over Highlight Cell Rules.  

4. Select Less Than to open the Less Than dialogue box. 
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5. Enter the value that you want to set as your upper limit for the Less Than condition  

6. Select Ok.  

 

The cells which contain a value less than the value you specified will now appear with the cell 

formatting which you selected. 

Between 

To highlight cells between two specific values: 

1. Highlight the data range.  

2. Select Conditional Formatting.  

 
 

3. Hover over Highlight Cells Rules to reveal the menu of different rules.  

4. Select Between to open the Between dialogue box. 

 

 
 

5. Enter the lower limit in the first box and the upper limit in the second box.  

6. Select the cell formatting.  

7. Select Ok.  

 

The cells which contain a value between the two specified values will now appear with the cell 

formatting which you selected. 

Equal To 

To highlight cells equal to a specific value: 

1. Highlight the data range.  

2. Select Conditional Formatting.  
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3. Hover over Highlight Cells Rules.  

4. Select Equal To to open the Equal To dialogue box. 

 

 
 

5. Enter the value that you’re looking for.  

6. Select the type of cell formatting you wish to use.  

7. Select Ok.  

 

The cells which contain the specified value will now appear with the cell formatting which you selected. 

Text That Contains 

To highlight cells that contain a certain character(s): 

1. Highlight the data range.  

2. Select Conditional Formatting.   

  
 

3. Hover over the Highlight Cells Rules.  

4. Select Text That Contains to open the Text That Contains dialogue box. 

 

 
 

5. Enter the character(s) you’re looking for.  

6. Select the type of cell formatting you wish to use.  

7. Select Ok.  
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The cells which contain the specified character(s) will now appear with the cell formatting which you 

selected. 

A Date Occurring 

To highlight cells that contain a certain date or date range: 

1. Highlight the data range.  

2. Select Conditional Formatting.  

 
 

3. Hover over the Highlight Cells Rules.  

4. Select A Date Occurring to open the Date Occurring dialogue box. 

 

 
 

5. Select the date or date range that you’re looking for.  

6. Select the type of cell formatting.  

7. Select Ok.  

 

The cells which contain the specified date or date range will now appear with the cell formatting which 

you selected. 

Duplicate Values 

To highlight cells that contain either duplicate or unique values: 

1. Highlight the data range.  

2. Select Conditional Formatting.   

 
 

3. Hover over Highlight Cells Rules.  

4. Select Duplicate Values to open the Duplicate Values dialogue box.  
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5. Select either Duplicate or Unique from the drop down menu.  

6. Select the type of cell formatting you wish to use.  

7. Select Ok.  

 

The cells which contain either duplicate or unique values will now appear with the cell formatting which 

you selected.  

Top/Bottom Rules 

Top and bottom rules can be used to highlight cells that are the top or bottom ten items or the top or 

bottom ten percent. They can also be used to identify items above or below the average.  

Top 10 Items 

To highlight cells that are the top 10 items in your data: 

1. Highlight your entire data range.  

2. Select Conditional Formatting. 

 
 

3. Hover over Top/Bottom Rules.  

4. Select Top 10 Items to open the Top 10 Items dialogue box.  

 

 
 

5. Enter the number of items to identify.  

6. Select the type of cell formatting you wish to use.  

7. Select Ok.  

 

The cells which are in the top selected number will now appear with the cell formatting which you 

selected.  

To identify the bottom 10 items select Bottom 10 Items instead of Top 10 Items.  
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Top 10% 

To highlight cells that are in the top percentage of items in your data: 

1. Highlight the data range.  

2. Select Conditional Formatting.  

 
 

3. Hover over Top/Bottom Rules.  

4. Select Top 10% to open the Top 10% dialogue box.  

 

 
 

5. Enter the number of items to identify.  

6. Select the type of cell formatting you wish to use.  

7. Select Ok.  

 

The cells which are in the top selected percentage will now appear with the cell formatting which you 

selected.  

 

To identify the bottom 10 percent select Bottom 10 Percent instead of Top 10 Percent.  
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Above Average 

To highlight cells that are above the average value of your data:  

1. Highlight the data range.  

2. Select Conditional Formatting.  

 
 

3. Hover over Top/Bottom Rules.  

4. Select Above Average to open the Above Average dialogue box: 

 

 
 

Select the type of cell formatting you wish to use. Select Ok. The cells which are above the average 

value of your data will now appear with the cell formatting which you selected.  

 

To identify items below the average value select Below Average instead of Above Average.  
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Data Bars 

Conditional formatting in Excel can be used to convert cells with numeric data into a bar graph. Two bar 

graph options are gradient and solid filled graphs.  

 

To convert data into a bar graph: 

1. Highlight your entire data range.  

2. Select Conditional Formatting.  

 
 

3. Hover over Data Bars.  
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4. Choose either Gradient or Solid and select a color for the bar graph.  

 

The data cells will now be filled with a gradient color based on the value in the cell. 

 
 

Color Scales 

You can use the Color Scales rules to color the cells in your data based on their numerical value. Color 

Scales makes it easier to visualize the data.  

 

To add a color scale to data: 

1. Highlight the data range.  

2. Select Conditional Formatting.  

 
 

3. Hover over Color Scales.  

 
 

4. Select a color scale.  

 

The data cells will now be displayed as a color scale based on the value of the cell.  
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New Rule 

If the rules outlined above do not cover what you need, you can create your own rule.  

 

To create your own rule:  

1. Highlight the cells in your data range.  

2. Select the Conditional Formatting tool.  

 
 

3. Select New Rule.  

 
 

The New Rule dialogue box will open.  
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4. Select the Rule Type.  

 

Each rule type will change the appearance of the dialogue box, as it changes the rule description.  

Clear Rules 

Clear Rules clears any conditional formatting rules from the selected cells, the entire spreadsheet, the 

table, or the pivot table.  

 

To clear conditional formatting:  

8. Select Conditional Formatting.  

 
 

1. Hover over Clear Rules.  

2. Select the range for which to clear conditional formatting.  
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Manage Rules 

Manage Rules allows you to view, edit, delete, and add rules.  

To manage conditional formatting rules: 

1. Select Conditional Formatting.  

 
 

2. Select Manage Rules. 

 
 

This will open the Conditional Formatting Rules Manager dialogue box: 

 

 
 

Select the formatting rules for dropdown to view rules for the current selection or any other worksheet 

or table within the workbook. You may add, edit or delete a rule from the Conditional Formatting Rules 

Manager.  
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SECTION V: Separating Text within a Cell 

When data is combined within a cell, such as a first and last name, Excel is able to separate this data into 

two cells.  

 

To separate data within a cell: 

1. Insert a blank column to the right of the column containing the merged data.  

2. Highlight the column of full names.  

3. Select the Data tab.  

4. Select Text to Columns.  

 
 

The Convert Text to Columns Wizard dialogue box will.  

 

5. Choose the appropriate data type.  

 

To separate a column based on punctuation characters, select Delimited.  

To separate a column based on spaces between each field, select Fixed Width.  

 

 For this example we will select Delimited. 

 
 

6. Select Next. 

 

7. Choose your delimiters for the text separation. 

  

For this example select Space. 

 
 

8. Select Next.  

 

9. Select the data format for each column.  

For this example select General. 
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10. Select Finish.  

 

Data will be displayed as separate columns.  

 

 

SECTION VI: Sorting 

Sorting allows for alphabetic, numeric, color and even multi-level organization.  

 

Alphabetical 

To sort the data alphabetically: 

1. Select the column to sort.  

For this example we will sort by last name.  

 

2. Highlight the column.  

 

3. Select the Data tab.  

Sorting options are located in the Sort & Filter section.  

 

The Sort action, circled in blue below is used to alphabetically organize data.  

 The A-Z descending button is used to sort data from the lowest to highest values.  

 The Z-A descending button is used to sort data from the highest to lowest values.  
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4. Select the A-Z to alphabetize the data within the column.  

 

A Sort Warning dialogue box will appear. This will ask if you want to expand the selection or continue 

with the current selection.  

 

5. Select Expand the Selection. This will sort the entire data sheet based on the column instead of just 

sorting the column selected.  

 

The data will be displayed alphabetically.  
 

 
 

Numerically 

 To numerically sort data from lowest to highest values: 

1. Select the column  

2. Select the A-Z sort button to sort data from smallest to largest quantity.  

 

Select the Z-A sort button to sort data from largest to smallest quantity.  

 

Multi-level Sorting 

A data table may also be sorted by using multiple criteria.  

 

For this example we will sort by Semester and then by Last Name using the following table:  
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1. Select the first column to sort. 

 

2. Select the Sort button, circled in red. 

 
The Sort dialogue box will appear: 

 
 

3. Open the Sort By dropdown.  

4. Select the appropriate name of the column to sort first. For this example we will use Semester.  

5. The Sort On dropdown should remain as Values.  

6. To alphabetically sort data, select A-Z.  

7. Ensure the My Data Has Headers option is selected to differentiate between column headers and 

data. 

8. Select Add Level to add additional criteria to sort by.  

The Then By criteria will appear.  
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9. Select Last Name from the Then By dropdown box. 

 

10. The Sort On dropdown should remain as Values.  

 

11. The Order dropdown should be A-Z. 

  

12. Click Ok. 

The table will now be sorted alphabetically by semester and then by last name.   

 

 
 

Sorting by Cell Color 

To sort a color coded data table:  
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For this example we will organize the table with green at the top, yellow in the middle, and red on the 

bottom.  

 

1. Highlight the column of cells to sort.  

2. Select Sort.  

 
   

 The Sort dialogue box will appear.  

 

 
 

1. Open the Sort By dropdown. 

2. Select the name of the column to sort.  

3. Select Cell Color from the Sort On dropdown.  

4. Select the color to be displayed at the top of the data sheet from the Order dropdown.  

5. Ensure On Top is selected.  

6. Select Add Level to add another sort criteria.  

7. Select the same column from the Then By dropdown.  

8. Select Cell Color from the Sort On dropdown 

9. Select the color to be displayed at the bottom of the data sheet. 

For this example we will use the color red.  
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 Your dialog box should now look like this: 

 
 

10. Select Ok.  

 

The data table will now be sorted by color.  

 

 
 

If there are more than three colors in the data sheet: 

Follow the same process, but for each additional sort level added in the Sort dialogue box, select for 

each color to be displayed on top.  

 

For example, data that contains five different colors would look like this:  
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Once sorted, the data table will appear like this: 

 

 

SECTION VII: Filters 

Filters allow data to be limited to only display data which meets the criteria of the filter. Data which does 

not meet the criteria of the filter is hidden. 

 

To apply a filter: 

1. Select the range of data to filter  

 

2. Highlight the headers of each column of data to filter.  

To highlight all header columns select the entire first row. 

 

3. Select Filter. 

 
 

A dropdown arrow will appear to the right of each column header.  

 

 
 

Filters may be applied to each column of data. To apply a filter, open the dropdown menu and select the 

criteria to display.  

 

For example: to view all items that were paid in May: 

1. Select the arrow to open the dropdown menu to filter.  

2. Unselect the Select All checkbox. 

3. Select the checkboxes you wish to display.  

 

To filter further than the options that are made available: 
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1. Hover over the Date Filters option. (This may also be displayed as column, text or number filters, 

depending on the contents of the column).  

4. Select the appropriate filter option to filter the data.  

 
 

In this example, we will select Before.  

 

A dialog box titled Custom AutoFilter will open.  

 

 
 

Enter the parameters for the filter in the Custom AutoFilter dialog box. 

Select 6/1/2014 from the calendar dropdown menu to the right of the Is Before dropdown.  

Click Ok. 

  

 

The result will look like this: 
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This process may be used to filter any column.  

 

*All sort and filter functions can also be found from the dropdown Sort & Filter menu in the Editing section 

 

Section VIII: Functions and Formulas 

Basic Functions/Formulas 

Excel has many different functions and formulas which can be used to manipulate data in a variety of 

ways, such as sums, subtotals, averages, number counts, maximums, and minimums.   

Sums 

One of the most commonly used functions of Excel is summation. If you have a data table for a single 

student with amounts and dates of payment, to find the sum of all payments, you would use the 

summation function.  

 

 
 

To add numbers in a column: 

1. Select the cell directly beneath the last entry.  

2. Select Auto Sum located on the Formulas tab.  

 
 

3. Select the AutoSum button 

4. This will select all items within the column 

5. Click the Enter key on your keyboard to calculate the sum of all fields.  

Other functions are available by selecting the AutoSum dropdown 
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Other functions include: averaging the numbers in a column, counting the numbers in a column and 

finding the minimum and/or maximum numbers in the column.  

 

Additionally, there is an AutoSum button and dropdown menu also located on the Home toolbar.  

 
 

Subtotaling 

The Subtotal tool is used sum data by group. Subtotaling data eliminates the need to manually insert a 

row and perform a summation.  

  

 Below is a sample data sheet for which we need to calculate the total amount paid for each semester. 

 

One Level Subtotals 

To Subtotal a data sheet: 

1. Select the Subtotal button located on the Data toolbar.  

 

 

 
 

  The Subtotal dialogue box will open 
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To subtotal this data sheet by semester: 

1. Choose Semester for the At Each Change In dropdown. 

2. Select Sum for the Use Function dropdown.  

3. Choose Amount Paid for the Add Subtotal To field.  

4. Click Ok. 

 

Subtotals will automatically be added to your data.  

 

 
 

 

 

 

 

 

The subtotal hierarchy located to the left of the spreadsheet can be used to hide some of the data within 

the spreadsheet.  

To view only the grand total, select column 1 

To view the total for each subsection, select column 2 

To view all data, select column 3.  
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Nested Level Subtotals 

Nested Level Subtotals are used to subtotal more than one level of data.  

For this example our list of data contains individual payers and semesters 

 
 

1. Select any cell within your range of data 

2. Select Subtotal on the Data tab.  

 
 

The Subtotal dialogue box will open.  

 

3. For the At Each Change in dropdown menu, select Semester. 

4. Choose to Use Function, Sum. 

5. Choose to Add Subtotal To, Amount Paid.  
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6. Click Ok.  

 

The first level of subtotal will be added to the data.  

 

 
 

To add an additional level of subtotals: 

1. Select Subtotal 

2. For the At Each Change in dropdown menu, select Last Name.  

3. Choose to Use Function, Sum. 

4. Choose to Add Subtotal To, Amount Paid.  
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5. Ensure the checkbox Replace Current Subtotals is unchecked.  

 
 

6. Click Ok.  

The second level of subtotals will be added to the data range: 
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Removing Subtotals 

To remove subtotals from a data sheet: 

1. Select the Subtotal tool 

The Subtotal Dialogue box will appear.  

 

2. Select Remove All to remove all subtotals.  

 

 
 

Average  

To find the average of a select range of data: 

1. Select the cell directly beneath the range of data 

 
 

2. Select the Auto Sum dropdown on the Formulas tab.  

 
 

3. Choose Average from the Auto Sum dropdown 
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4. Select the range of cells to calculate 

5. Click Enter on your keyboard 

 
 

  

Count Numbers 

To count the number of items in a range of data: 

1. Select the cell directly beneath the range of data.  

 
2. Select the Auto Sum dropdown. 

3. Select Count Numbers. 
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4. Select the range of cells to calculate. 

5. Click Enter on your keyboard.  

 
   

 

Maximum and Minimum 

To calculate the Maximum or Minimum for a range of data: 

1. Select the cell directly beneath the range of data.  

 
 

2. Select the Auto Sum dropdown. 

3. Select Max or Min to calculate the maximum or minimum values 

        
 

6. Select the range of cells to calculate. 

7. Click Enter on your keyboard to calculate the value.  
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